Intel® Platform Instrumentation Control Console

User’'s Guide
Version 2.4
Part Number: 754123-005

Legal Information

What Is Platform Instrumentation Control?]
Launching PIC

Using PIC

Managing Servers with PIC

Customizing PIC Administrator Options
PIC Event Messages

Appendix A DMI to SNMP Translator




Intel Platform Instrumentation Control Version 2.4
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What Is Platform Instrumentation Control?

Platform Instrumentation Control (PIC) uses the Desktop Management Interface (DMI) 2.0
framework to manage Windows NTT,Windows 2000, NetWaret, Linux, and UnixWare' server
hardware components. PIC provides real-time monitoring and alerting for server hardware
Sensors.

PIC has two main software components:

*  The managed server: PIC Server Instrumentation (called Platform Instrumentation [PI]) is
installed on the NetWare, Windows NT,Windows 2000, Linux, or UnixWare server that is
going to be managed by the PIC Consol e software.

«  The managing console: PIC Console software isinstalled on the user console that
will manage the server.

On aWindows NTor Windows 2000 network, it is possible to install both parts of the software on
the same server. It isalso possibletoinstall both the Server Instrumentation and the
Consol e software on multiple systems.
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Features

The following list summarizes the features of PIC:

Graphical user interface

Consolidated server health information

Interchassis management via the Intelligent Chassis Management Bus (ICMB)

Enterprise console integration (PIC runs under HP Network Node Manager; Intel®
LANDesk® Server Manager; and CA-Unicenter’ TNG, as well as under the Intel® Server
Control Console)

Remote installation

RPC-based transport mechanisms

DMI 2.0 service providers

System administrators can use PIC to:

Remotely monitor server hardware sensors

Configure sensor thresholds

Update the server’s LCD display (if available)

Configure, receive, and act upon alert eventsin the system event log (SEL)
Configure audio or visual notifications in response to an event

Configure options to shut down, reboot, or power-off the system automatically in response to
an event
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Tracking System Status

Using PIC, you are able to track system status and manage hardware conditions such as:
e Temperature
e Voltage
e Cooling fan status
¢ Chassisintrusion
 ECC memory
e Processor status
e Power supply status
e PCI Hot Plug (PHP) slot status

Some of these conditions have a threshold or range of acceptable values. Default values are
configured during system manufacturing. These values, along with the current readings, error
status, and timer settings, can be configured and monitored through PIC. An event occurs when a
parameter crosses a defined threshold. At the time an event occurs, PIC initiates the action you
have configured.

For example, if the temperature reaches alevel that is outside of the user-defined threshold, an
event has occurred. Y ou can configure PIC to respond to this event in multiple ways, such as:
» Display amessage or sound an alert
e Shut down the server
* Record the event in asystem log




Intel Platform Instrumentation Control

Y ou can also use PIC to view:

e System hardware inventory

e BIOS and system slot information

e Onboard Adaptec™ SCSI controller status

e Onboard LSl (Symbios) SCSI controller status
e Onboard Intel® LAN adapter status

Version 2.4
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Managing Third-Party Components, DMI, and MIF Files

PIC uses the Desktop Management Interface (DMI) to monitor components, such as hardware
sensors, inventory information, and third-party instrumentation on server systems. PIC monitors
the motherboard, chassis, onboard Adaptec and LSIT (Symbios) SCSI controllers, and onboard
Intel LAN adapters.

To provide these capabilities, each DMI-enabled component must provide a Management
Information Format (MIF) file, which describes the manageabl e attributes of that component. For
example, the current reading of atemperature sensor is an attribute that could be listed in aMIF
file.

The PIC Console GUI running on aloca management console (Windows NT, Windows' 98, or
Windows 2000) can manage components on a remote managed server (Windows NT, Windows
2000, NetWare, Linux, or UnixWare). PIC also includes atranglator to allow management of the
DMI-enabled component instrumentation from a remote SNMP application.

For more information on DMI, see the Desktop Management Task Force (http://www.dmtf.org) on
the World Wide Web.
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Getting the Latest Information and Support

PIC is frequently enhanced and updated to support new features and platforms, and to address
issues discovered within the application. For updated information on such changes, see the PIC
release note files (ENUREADME.TXT and ENUERRATA.TXT). If you have questions or need
help using PIC, contact your service representative.
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Glossary

The following terms and abbreviations are used in this document:
Term Description

DIMM Dual In-line Memory Module

DMI Desktop Management Interface

DPC Direct Platform Control

ISC Intel Server Control

LDSM LANDesk Server Manager

MIF Management Information File, used by DMI for describing component

instrumentation

MMC Microsoft Management Console

NMI Non-Maskable Interrupt

ONC Open Network Computing

PHP PCI Hot Plug

PIC Platform Instrumentation Control

RAID Redundant Array of Inexpensive Disks
RPC Remote Procedure Call




Intel Platform Instrumentation Control Version 2.4

Term Description

SBE Single-Bit Error

SEL System Event Log

SMI System Management Interrupt

SNMP Simple Network Management Protocol, a standard network protocol for
management information

SSU System Setup Utility

10
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Launching PIC

PIC can be launched from and can manage servers from one of these management environments:
e LANDesk Server Manager (LDSM)
e HP Network Node Manager
* CA-Unicenter TNG
* Intel Server Control Console

Once the PIC GUI application is launched from a management console, the management console
application can terminate, and PIC will continue to operate normally.

LANDesk® Server Manager

The LDSM console dynamically buildsits feature set when communication is established with a
managed server. If the managed server isrunning the Platform Instrumentation software, the
LDSM console adds an option for “Platform Instrumentation Control” as alaunch point in the
Tools branch of the LDSM navigation tree. Select this option to launch the PIC applet.

11
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HP Network Node Manager

The HP Network Node Manager Consol e autodetects servers running the PIC Component
Instrumentation software. The Console updates the server bitmap with a PIC server icon for those
servers.

To launch the PIC applet, select an PIC-enabled server on the HP Console network map, and then
select the "Platform Instrumentation Control Applet" option from the Tools Menu. Alternatively,
you can launch the PIC applet by selecting an PIC-enabled server on the HP console network map,
clicking the right mouse button, and then selecting the "Platform Instrumentation Control” option
from the popup menu.

CA-Unicenter TNG

The CA-Unicenter TNG Console autodetects servers running the PIC Component Instrumentation
software if you have enabled the PIC to CA discovery service. To enable discovery, you must start
the "Intel Tng-PIC AutoDiscovery” service. You can start this service from either the TNG
Unicenter "Auto Discovery" dialog or from the Windows NT "Services' applet.

The"Intel Tng-PIC AutoDiscovery" service creates a new "Platform Instrumentation Control"
TNG object for each server having the PIC Component Instrumentation software. That TNG
object displays on the map as a child of the "PIC World View" and as a child of the PIC-enabled
server. You can view al PIC-enabled servers under the "PIC World View."

12
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To launch the PIC applet, right-click on a"Platform Instrumentation Control" icon, and select the
“Launch PIC" option from the popup menu.

Intel® Server Control Console

The Intel Server Control Console is a management console that provides basic server management
without having to use an enterprise management console (such as HP OpenView) or aworkgroup
management console (such as LANDesk Server Manager).

To launch PIC from within the Intel Server Control Console, click the PIC icon in the Tool Pane.

13
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Using PIC

When you start PIC, the main window displays atree view. Y ou can expand the view to show the
sensor types supported on the managed server and further expand it to display detailed sensor
information.

A presentation area on the main PIC window displays current readings, threshold configurations,
inventory, and other related information for selections made in the tree view. The main window
aso displaysthe server’s LCD (if available) and a picture of the PIC bitmap.

Most of the PIC sensors have associated thresholds that trigger alert actions when the thresholds
are crossed. You can:

»  Specify which alert actions you want to occur.
e Maodify the default thresholds.
« Configure the default actions and notifications for each threshold.

14
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When a parameter crosses a threshold, you can have PIC:

»  Beep the speaker on the managed server.

e Display an alert on the managed server.

» Logtheevent to disk on the managed server.

e Broadcast a message.

»  Write amessage to the LCD on the managed server.

e Page an administrator.

e Use one of the shutdown/power control options to shutdown the OS, do a hardware reset, or
power-off the server.

« Runany LANDesk Alert Management System (AMS?) alert action if LANDesk Server
Manager isinstalled on the managed server and managing console. For more information on
AMS?, seethe Intel LANDesk Server Manager Administrator’s Guide.

The PIC Console Main Screen

PIC uses a Windows Explorer-like model, with a navigation pane (tree view) and a presentation
pane (list view). When you select a sensor from the tree, the presentation pane shows a set of
tabbed pages with sensor-specific information.

15
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Main Menu bar
Icon Toolbar
Navigation Pane)
LCD Display Pane
Status Bar
Presentation Pane

The main screen of the PIC application is continually updated to show current sensor status.
Specific PIC sensor dialogs (such as temperature and voltage sensors) show the current sensor
reading when displayed but are not dynamically updated.

moow>»

T
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Main Menu Bar

The Main Menu Bar includes the following options:

Item Options
File Menu Exit: Exits the application
View Menu Toolbar: Toggles the toolbar on or off.

Configure Menu

Status Bar: Toggles the status bar on or off.

PIC Bitmap: Toggles the PIC bitmap pane on and off.

Large Icons: Displays list using large icons.

Small Icons: Displays list using small icons.

List: Displays items in list format.

Details: Displays items in detail format.

Arrange Icons: Arranges icons by name or status.

Refresh: Triggers an immediate screen and data refresh.

Options: Displays the view options dialog so you can configure viewing preferences,
such as temperature format and display refresh rate.

Enable Front Panel Power & Reset: Toggles the front panel power and reset option.
Enable Watchdog Timer: Toggles the watchdog timer option. When this option is
enabled, you can set the timer value.

Watchdog Timer Value: When the watchdog timer option is enabled, the timeout
dialog appears so you can set the timeout value. When the timer is disabled, the
dialog does not appear.

Restore Factory Defaults: Restores factory default values for threshold sensors,

18
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console refresh interval, and the Watchdog Timer.

Paging Configuration - This command takes you to the paging Configuration dialog
box.

ICMB Menu View Managing Server: Enables the default local managing server view.
View Managed Server(s): Accesses the ICMB-managed server view(s).
Reclaim Inactive Resources: Reclaims inactive ICMB resources on the managing
server.

Help Menu Help Topics: Accesses PIC help topics.

About PIC: Displays PIC version information.

19
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Toolbar

The toolbar allows quick access to some menu items. To hide the icon toolbar, click the right
mouse button over the toolbar, and then click the Hide item that appears.

Navigation Pane

The Navigation Pane shows atree view of server components that can be monitored. Many
branches of the tree represent group components that have subbranches (nodes). These group
items are identified by the tree expansion icons (“+” or “-") appearing to the left of the component
name. These branches can be expanded to list nodes (detail sensor list) or collapsed to hide nodes.

Server BitMap

The Server Bitmap shows a picture of the server splash screen. To hide the picture, click the right
mouse button over the picture, and then click on the “Hide” popup menu that appears or click on
the PIC Bitmap icon on the toolbar.

20
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LCD Display

The LCD Display Pane shows the actual server LCD contents and a button to set the LCD contents
on the server. If the server hardware does not support L CD, the pane does not display.

Status Bar

The Status Bar displays status messages. To hide the status bar, click the right mouse button over
the status bar, and then click on the “Hide” popup menu that appears.

Presentation Pane

When you select a branch (group component) in the navigation pane, the presentation pane
displays a set of icons (list view) representing each group node (detail sensor list). The detail view
provides more information on each node item. Y ou can arrange these list view items by name
(sorted alphabetically) or by status (sorted by current status: critical, noncritical, and OK). To
change the presentation pane, click the right mouse button over the pane, and then select from the
popup menu that appears. This popup menu has two items:

* View— Changes between large icons, small icons, list, or detail view
* Arrangelcons— Arranges the list view icons by name or status

21
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When you select a node in the navigation pane, the presentation pane displays a set of tab pages
representing the detail sensor information. Depending on the node selected in the navigation pane,
one of the following four pagesis displayed:

Sensor Settings— Displays the sensor’ s current status and current value, threshold values
and error counts.

Use this screen to configure new threshold values (such as Upper Critical Threshold, Upper
Noncritical Threshold).

The sensor statusis also represented as a colored “Health” icon: Red iscritical, Yellow is
noncritical, Green is OK, and Blue is an unsupported sensor.

Alert Actions— Displays the currently configured alert actions for each threshold type (such
as Voltage-Status Changed to Upper Critical, V oltage-Status Changed to Lower Critical).

Use this screen to change the aert actions for each supported threshold. The factory default
alert actions are Log the Event to Disk and Write aMessage to the LCD. The AMS Alert
configuration option is available only when PIC isintegrated with LDSM; when this feature
isnot available, the AMS Alert option is disabled.

Sensor Infor mation— Displaysindividual sensor information (such as Sensor Tolerance,
Maximum Reading, Minimum Reading).

Inventory I nfor mation— Displays inventory information for the sensor (such as
Description, Manufacturer). The information varies based on the sensor type.

22
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Sensor Dialogs

Alert Actions

All of the sensor dialogs have an Alert Actionstab. Use thistab to specify the actions to be taken
in the event of an aert on the associated sensor.

The factory default alert actions are to log the event to disk and to write a message to the server’s
front-panel LCD.

The AMS dert configuration is only available when PIC isintegrated with LANDesk Server
Manager (LDSM). When this feature is not available, the corresponding GUI controls will be
disabled.
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Sensor Information

Each sensor has a sensor information tab that displays individual sensor information, such as
specifications and reading extremes.

Sensor Settings I Alert Actions | Inventary Information I

MName Walue |
Sensor Accuracy

Sensor Tolerance

Sensor Fesolution

Mominal Reading

Maximurm FReading

Minirmurm Reading

Lowest Normal Reading

Highest Narmal Reading

Help |

25
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Inventory

Each sensor has an inventory information tab that shows information about the sensor.

Sensor Seftings I Alert Actiong I Sengor Information

MName

Description
tanufacturer
hodel

Part Murnber
Component Number
Serial Number
Fevision Level

Help |
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Health

Information about all unhealthy sensorsis copied under the Health branch. Select the Health
branch of the server tree in the navigation pane to get a quick and simple view of the current server
health. If, for example, a 12V voltage sensor indicates that the current statusis not OK, then data
about that 12V sensor is added to the Health branch of the tree. Y ou can select the 12V entry in
either the Health or Voltage branch of the tree to display information about the sensor.

All sensorsin either acritical or noncritical condition will appear in the Health branch of the tree
in addition to their normal location in other areas of the navigation tree. In thisway, you can get a
quick summary of problem areas on your server and begin corrective actions.

Colored iconsin the Health branch of the server tree indicate individual sensor status and overall
server status:

e Green: heathy server

e Ydlow: noncritical conditions

e Red: critical failures

e BlueQuestion Mark: unsupported sensors
The color of the overall server health icon will display the state of the most severe sensor status. If
any sensor isin acritical condition (regardless of other sensors being in a noncritical condition),
the server health status will be shown as critical (red). If there are only noncritical sensors, the
server health status will be shown as noncritical (yellow). If al sensors report normal conditions,
the server health status will be shown as OK (green).
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Chassis

PIC monitors chassis door open/closed switches for managed servers that support thisfeature. The
number of sensors monitored depends on the server chassis.

The chassis intrusion sensor screen displays the current security status. Not all servers support this
component.

Sensor Sefings |AIertActiDns| Sensurlnfurmatiunl Inventurylnformationl

O Current Status Ok
Error Count
’7 Critical ; 0

Help |

When a chassis door that includes an open/close switch is opened, the vulnerable state is indicated
asacritical condition in the health branch of the PIC Console, and the requested event actions are

carried out. When al chassis doors that include an open/close switch are closed, PIC indicates the
chassisis secure and carries out the requested event actions.

For systems that do not support chassis open/closed switches, this portion of the PIC Console will
either not display or the chassis status will be reported as “ Unknown.”
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Fan

The fan sensor screen displays actual fan RPM for systems that support this feature. The threshold
appears in terms of the RPM value. If the current fan RPM value falls below the specified
threshold value, then the sensor status changes and an event generates. For the systems that do not
support fan RPM threshold, the threshold setting is 0 and read-only. If the fan stops, then the
sensor status changes and an event generates.

Sensor Setings |AIertAc:tic|n5| Sensurlnfurmatiunl Inventurylnfurmatiunl
QCurrem Status (0]
Current Value : 1655 RPh
~Threshaold
WprerEritical hreshcld I ill R
WaperiN ar=Crtieal Mhrestold I i’ B
Lower Non-Critical Threshold IWZUU i’ RPh
Lower Critical Threshold IEIDD i’ FFM
—Error Count
Mon-Critical : 1]
Critical : 1]
Apply I Help
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PIC monitors two types of fans:

* Rotation-sensing fans—PIC can detect whether afan has stopped but is not able to indicate
which fan hasfailed. These fans, together, are treated as asingle fan unit. Therefore, event
actions must be configured for all fans together, rather than separately.

e RPM-sensing fans—PIC can detect whether an individual fan has either slowed or stopped
and will display the actual fan RPM value for systems that support this feature. Each RPM-
sensing fan is independently configurable with its own threshold and event actions.

If arotation-sensing fan fails or an RPM-sensing fan crosses a threshold, the PIC Console displays
the event as a critical condition viathe health branch of the software, and the requested event
actions are carried out.

For systems that do not support afan RPM threshold, the threshold setting displaysa“0” and is
read-only in the PIC Console display.
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ICMB

The ICMB diaog allows you to configure options for the Intelligent Chassis Management Bus
(ICMB).

The ICMB feature allows multiple remote devices to be interconnected and management
information shared among them. For example, your managed server could be configured to be an
ICMB primary server and report management information on other ICMB devices connected to it.
Using ICMB, PIC can manage the power state of remote ICMB devices and view FRU information
about those devices. The amount of FRU information available depends on the type of ICMB
device you are trying to manage.
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Through the PIC Console, you can switch your view of the primary managed server to one of the
ICMB-managed devices and view the available information on that device without losing the
connection with the primary server. Y ou can change your view back to the primary server or any
other ICMB-managed device at any time. Through the PIC Console, you can configure the ICMB
management features of the primary managed server and the remote |CMB-managed devices.
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e Local ICMB Server Configuration— With thisoption it is possible to enable the local
server as a management point, enable the full sensor view of remote devices, and change the
discovery period for remote devices.

* Remote | CMB Chassis Configuration— With this option it is possible to configure each
remote device discovered viaICMB. Y ou can decide whether to manage the remote device,
enable full sensor view for the remote device, and set the event polling rate for the remote
device.

Y ou can reclaim inactive ICMB system resources on the primary server. Doing so frees the
memory taken up by the SDR and FRU information on the primary server for any remote device
that is no longer visible on the network (vialCMB).
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Memory Array

The memory array sensor screen displays information and status about each memory array.
Sensor-specific information is displayed in the Sensor Information tabbed page. Not all servers
support this component.
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Memory Device

The memory device sensor screen displays information and status about each memory device.
Sensor-specific information is displayed in the Sensor Information tabbed page. Not all servers
support this component.

sSensor Seflings |AlenAdiDns| Sensurlnfurmatinnl Inventm‘ylnfurmationl

OCurrent Status (0]
Errar Caunt:
MNaon-Critical : 0
Critical : 0

Help

PCI HotPlug Device

The PCI HotPlug Device sensor screen displays information about each PCI Hot Plug device
installed inaPHP dot. If the server hardware does not support PCI HotPlug it will not appear in
the navigation pane and the screen will not be available.
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Power Supply

The power supply sensor screen displays information and status about each power supply. Sensor-
specific information is displayed in the Sensor Information tabbed page. Not all servers support
this function.
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Power Unit

For systems that support it, PIC monitors the status of the power suppliesin the managed server.
Each power supply isindependently configurable for event actions upon failure. The power unit
sensor screen displays information and status about each power unit. Not all servers support this

component.

sSensor Seflings |AlenAdiDns| Sensurlnfurmatinnl Inventm‘ylnfurmationl

OCurrent Status (0]
Errar Caunt:
MNaon-Critical : 0
Critical : 0

Help

If a power supply reports a predictive failure condition, then PIC reports the status as a non-critical
condition in the health branch of the PIC Console software, and the requested event actions are

carried out.
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If apower supply fails, the failure is reported as a critical condition in the health branch of the PIC
Console software, and the requested event actions are carried out. PIC also reports the system
power as nonredundant and as a noncritical condition in the health branch of the PIC Console
software, and the requested event actions are carried out.

For systems that do not support power supply sensors, this portion of the PIC Console software
will not display.

For those systems that support it, PIC monitors the managed server’s system power redundancy
status.

If apower supply fails or if the surplus power on the systemis less than the amount provided by
one power supply, PIC reports that the system power is nonredundant. This condition is indicated
with anoncritical statusin the health branch of the PIC Console software and the requested event
actions are carried out.

Processor

The processor sensor screen displays information and status about each processor. From this
screen, you can find out the type and speed of the processor. Sensor-specific information is
displayed in the Sensor Information tabbed page. Not all servers support this function.
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Sensor Settings | Alert Actions | Sensar Infarmation | Inventary Infarmation

OCurrent Status CK.
Error Count:
Man-Critical : 0
Critical : 0

Help

For motherboards that support it, PIC monitors processor failures during runtime and system boot
on the managed server. If asupported motherboard includes multiple processors, each processor
can be configured and monitored separately through PIC. If aprocessor failureis detected, the
failureisreported asacritical condition in the health branch of the PIC Console software, and the
requested event actions are carried out.

If processor sensors are not available on the motherboard, this portion of the PIC Console does not
display.
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System Slots

ISC gathers sensor information and slot status on all slots in your managed server. The dots are
categorized into two groups:

e PCI Hot Plug (PHP) slots (if the server hardware supports PCl HotPlug)

» All other non-PHP system slots.
Slot names containing “PCl 64bit” identify PHP slots. For PHP dots, there are three pages
available in the presentation pane: Sensor Information page, Sensor Status page, and Alert Action
page.
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For non-PHP dlots, only the Sensor Information pages displays.
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System Information

PIC gathers information on field replaceable unit (FRU) componentsinstalled in your managed
server. Thisinformation includes a component description, manufacturer, model, part number,
component number, serial number, and revision level. PIC also gathersinformation on other
system resources including Operating System, BIOS, and the System Event Log.

The inventory screen displays alist of components within the system. The inventory list shows the
description, manufacturer, model number, part number, serial number, and revision level of
baseboard components. The inventory list will include information on the baseboard, processor
board, chassis, power share board, hot-swap backplane, and memory devices.
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Irevertory Information

Name

Walue

Description
Manufacturer
Model

Part Mumber
Component Number
Serial Mumber
Fevision Level

Help

Version 2.4

If your server does not support one or more of these features, these portions of the PIC Console

will not display.
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Temperature

The temperature dialog contains all temperature sensors. Y ou can see individual sensor
information in the presentation pane by selecting the corresponding sensor node from the
navigation tree. Y ou can monitor current temperature readings, current status, sensor error counts,
and set sensor thresholds. Depending on the individual temperature sensor and the server
platform, some thresholds are unsupported and they appear disabled, grayed out, in the control.
The statusindicator in the upper left-hand corner shows the current status: ared stop sign means
“Critical,” ayellow caution sign means “Non-Critical,” and a green traffic light means “OK.”
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This table displays the information available for the temperature sensors.

Iltem

Description

Maximum Reading

The highest reading supported on this sensor.

Minimum Reading

The lowest reading supported on this sensor.

Sensor Accuracy

The sensor’s accuracy in +/- hundredths of a percent.

Sensor Tolerance (plus)

The amount of variation over the actual value that can be reported.

Sensor Tolerance (minus)

The amount of variation under the actual value that can be reported.

Sensor Resolution

The smallest unit of measurement reported by the sensor.

Nominal Reading

The expected normal reading for this sensor.

Lowest Normal Reading

The lowest normal reading of this sensor. Readings below this value indicate
an abnormal condition.

Highest Normal Reading

The highest normal reading of this sensor. Readings above this value
indicate an abnormal condition.

Third-Party

Y ou can configure event actions for DMI indications generated by third-party Server
Instrumentation installed with PIC. Y ou can also monitor third-party instrumentation viathe DMI
Explorer Interface. PIC supports event configuration for Adaptec SCSI, LS| (Symbios) SCSI, and
Intel LAN Adapter Server Instrumentation.
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Voltage

In a managed server, PIC monitors many types of voltage sensors; the number and type depend on
the server hardware configuration. Each monitored voltage sensor has independently configurable
thresholds and event actions. Example voltage sensors are:

« 12V,5V, 35V, 33V, -5V, -12V
¢ Processors 1.5V and 2.5V
e SCS| A Termination 1, 2, and 3

The voltage dialog contains all voltage sensors. Y ou can see individual sensor information in the
presentation pane by selecting the corresponding sensor node from the navigation tree. With this
control, you can monitor current readings, current status, sensor error counts, and set sensor
thresholds. Depending on the individual voltage sensor and the server platform, some thresholds
are unsupported and they appear disabled (grayed out) in the control. Theindicator in the left-
hand corner shows the current status: ared stop sign means “ Critical,” ayellow caution sign means
“Non-Critical,” and a green traffic light means “ OK.”
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This table displays the information available for the voltage sensors.

Item Description

Maximum Reading The highest reading supported on this sensor.

Minimum Reading The lowest reading supported on this sensor.

Sensor Accuracy The sensor’s accuracy in +/- hundredths of a percent.

Sensor Tolerance (plus) The amount of variation over the actual value that can be reported.

Sensor Tolerance (minus) | The amount of variation under the actual value that can be reported.

Sensor Resolution The smallest unit of measurement reported by the sensor.
Nominal Reading The expected normal reading for this sensor.
Lowest Normal Reading The lowest normal reading of this sensor. Readings below this value indicate

an abnormal condition.

Highest Normal Reading The highest normal reading of this sensor. Readings above this value
indicate an abnormal condition.
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Managing Servers with PIC

Viewing / Configuring Sensor Information

To view or configure a sensor (such as voltage, temperature), do the following steps:

1. Onthe PIC main window, click beside a sensor name in the navigation pane to see the list of
available sensors.

2. Select an entry fromthelist.

3. Switch between the available tab pages (Sensor Settings, Alert Actions, Sensor Information
or Inventory Information) to view or update the information.

4. Click <Apply> for any changes made to the sensor configuration.

At any time you can change views to another sensor by selecting another component in the
navigation pane.

If you try to change your view and you have not saved any configuration changes using the Apply
button in the presentation pane, PIC prompts you to save or discard the changes before switching
to anew view.
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Viewing System Information

To view system information (such as FRU, Operating System, BIOS, SEL) on the managed server
(or managed ICMB device), do the following steps:

1. Onthe PIC main window, click beside the System Information name in the PIC navigation
pane to see the list of options.

2. Select an entry from the list.

3. View theinformation in the corresponding tab page in the presentation pane.

At any time you can change views to another sensor by selecting another component in the
navigation pane.

On components that support FRU data, this inventory information is also displayed on the
Inventory Information tab page associated with that component.
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System Event Log

The PIC Console software displays the System Event Log (SEL) maintained by the managed
server's platform hardware. The SEL isacollection of log entries stored in nonvolatile flash
memory.

The Platform Instrumentation automatically extracts event information from the SEL and triggers
any user-configured actions associated with that event. The Platform Instrumentation clears the
SEL when it is near an out-of-space condition. The PIC Console software also displays the SEL
logging status (whether the SEL is Active or Inactive).

The SEL records displayed through PIC include additional timestamp information not available
when reading the raw SEL file through DPC or Client SSU. The platform instrumentation code
sets the timestamp of SEL records written prior to a system boot record using the timestamp from
the boot record.
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Configuring Thresholds

There are two basic types of threshold:
* Range-based thresholds for which avariety of values can be set. Example uses: for
temperatures, voltages, and RPM-sensing fans.

» State-based thresholds that have fixed values like OK or Critical. Example uses: for
rotation-sensing fan, chassis door, and memory array.

To Configure a Range-Based Threshold

Most voltage sensors, temperature sensors, and RPM-sensing fans have one, two, or four
configurable thresholds, depending on your server. Example thresholds are:

Upper Critical

Upper Noncritical

Lower Noncritica

Lower Critical

Some special sensors do not have configurabl e thresholds and are displayed for monitoring
purposes only.

Y ou can customize the threshold value to suit your working environment.
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Y ou can specify what action should occur when the sensor detects that one of the threshold values
has been crossed (i.e., the sensor state changes).

e Status Changed to OK

e Status Changed to Upper Critical

e Status Changed from OK to Upper Noncritical

e Status Changed from Critical to Upper Noncritical

These thresholds and sensor state changes let you configure progressive responsesin PIC to
increasingly serious hardware conditions. For example, noncritical thresholds might be configured
to emit a beep from the speaker and send a broadcast message, while critical thresholds might
require more serious actions, like a server shutdown.

To configure arange-based threshold:

1. Onthe PIC main window, click beside the sensor name in the navigation pane to see the list of
available sensors.

Select an entry from the list.

Change the threshold values as needed on the Sensor Settings tab page.

Click <Apply> for any changes made to the threshold value configurations.

If you want to change the event actions associated with threshold state change conditions,
make the changes on the Alert Actions tab page.

Click <Apply> for any changes made to the alert action configuration.

agkrwbd

o
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[] NOTE

After applying new threshold values that may cause an event indication, the
sensor status icon displayed on the Sensor Settings tab page may not change.
The consol e refreshes the display before the new threshold value takes effect
on the server, making it appear as though the sensor icon does not accurately
reflect the current state of the sensor. Use the menu option, View->Refresh,
or the F5 keyboard shortcut, to update the Sensor Settings tab page.

To Configure a State-Based Threshold

The state-based thresholds for processor, power supply, rotation-sensing fans, chassis door, and
memory arrays have afixed set of values, not arange. Example state change conditions:

e Single Bit Memory Error
e Processor Thermal Trip
e Power Supply Failed

[] NOTE

For systems that support rotation-sensing fans, the fan RPM threshold setting
displaysa“0" and is read-only in the PIC Console software.
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PIC generates an event whenever the state of these items changes. Y ou can specify which actions
should occur in response to changes. To configure a state-based threshold:

1

2.
3.

4.

On the PIC main window, click beside a sensor name in the navigation pane to see alist of
available sensors.

Select an entry from the list.

Select the Alert Actionstab. Change the event actions associated with a state change
condition.

Click <Apply> to save your changes.

Cautions in Setting Thresholds

Threshold Values Rounded Off

Hardware rounding causes set thresholds to not be the exact value set by software. Redisplay the
Sensor Settings tab page to find the actual value set by the software.
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Avoiding a Power On/Off Loop

Improperly setting event actions can cause the server to enter a state that prevents the server from

boating correctly. This can occur in the following scenario:

1. Anevent occurs. Example: a high-temperature threshold is exceeded.

2. Whilethe condition causing the event still exists, you set a Shutdown/Power Control Action,
like Immediate Power Off, to respond to this event.

3. Because the threshold has already been exceeded, no event is triggered to cause the Immediate
Power Off action to occur.

4. If you reboot the system and the event condition has not been corrected (such as the
temperatureis still over threshold), the system detects the temperature condition, triggers the
event, and the corresponding action is taken. In this example action, Immediate Power Off, the
system is automatically and immediately powered off.

When the system is powered up, an infinite loop of power-up and power-down begins. To break
this cycle, either:

Clear the event condition (cool down the system in this example).
or

Create afile named C:\LRA.NOT (or insert a diskette with file \LRA.NOT in A: drive) before the
OS boots. The existence of thisfile disables the software component that responds to the event.
The contents of the file are not important. Y ou must then delete this file after the problemis fixed
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to alow the software to operate normally. On UnixWare systems, either create aLRA.NOT filein
/ (root) directory or use the diskette described above.

Avoiding a Reboot-Fail Retry Loop

User-defined threshold values and other user-defined configuration attributes are written to disk
(persistent storage) so they are available when the server reboots. These “remembered” values
replace the PIC default values when PIC initializes.

When you change a threshold value or aert action in PIC, you can create an environment in which
an event isimmediately generated, such as setting the Upper Noncritical Threshold value below
the current sensor reading. If the configured event actions on this threshold included a Shutdown
or Power Control action as described earlier, the server would trigger the Shutdown or Power
Control action and could enter a reboot-fail-reboot-fail cycle using the new threshold value.

To help avoid this situation, PIC updates the server in two steps:

1. Any change you makeisvalid immediately in the active instrumentation, but PIC waits five
minutes before writing user changesto disk. Thus, if the change causes the server to reboot,
the previous value is restored from disk when the server reboots.

2. PIC then uses and displays the previous value, thus avoiding the immediate reboot-fail-reboot-
fail cycle.

Any change you make will be successfully written to disk as long as the motherboard
instrumentation continues running for five minutes after the change is saved.
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Configuring Threshold Event Actions

On the Alert Actions tab page, you can select actions that will take place when a sensor exceeds a
threshold or changes state. Severa options exist.
* Local actions:
O Audio/visua notifications (you may select more than one)
0 Shutdown/power control actions (you may only select one)
* Network actions:
0 AMS actions (if LANDesk Server Manager isinstalled on the server and consol€).

Generally, audio/visual notifications and AMS* alerts are for noncritical thresholds;
shutdown/power control actions are for critical thresholds.

AMS?-configurable alert actions include:
* Paging (disabled if the server hardware does not support Local Response Agent paging)
e Program execution
* SNMPtrap generation
* Message box, broadcast, and others

For more information on AMS? and its alert actions, see “Configuring AMS® Alert Actions” in the
Intel LANDesk Server Manager Administrator’s Guide.
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A CAUTION

If the OSis disabled by a non-critical event (such as avoltage surge), then
critical actions will not be carried out because the OS has been shut down. It
is best to use warnings (such as a speaker beep, a broadcast, etc.) for non-
critical conditions.
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The following tables|list the available actionsin PIC. Y ou can specify multiple audio/visual
notifications and AMS” alerts per event but only one shutdown/power control action.

Action

Description

Emit a beep from the
managed server’s speaker

Speaker emits a beep.

Display an alert message
on the managed server

Log the event to disk

Broadcast a message

Default action for noncritical and critical indications. The message box stays
up until acknowledged.

On UnixWare and Linux the alert message is displayed as a text message on
the server console.

Default action for all indications. This option records the event in the standard
system error log.

On NetWare, PIC records the event in the System Log, which you can view
with NetWare’s Syscon utility.

On Windows NT and Windows 2000, PIC records the event in the Windows
NT System Event Log, which you can view with the Windows NT Event
Viewer.

On UnixWare, events are logged in the system log file: /etc/.osm.
On Linux, events are logged in the system log file: /var/log/messages.
Default action for critical indications.

On NetWare, the message goes to all users currently logged into the
managed server with Administrator or Supervisor privileges.

On Windows NT and Windows 2000, the message goes to all the users
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currently logged into the managed server.

Note: Win98 cannot receive network broadcast messages from Windows NT.
If you configure a broadcast message and it is triggered on an NT server, the
message will not be received by any Win98 systems.

On UnixWare and Linux a text message is sent to all users currently logged
onto the UNIX server.

Write a message to the Default action for all indications. If the LCD is not available on the managed
managed server's LCD server, this option is grayed out and disabled.
Page an administrator A page is sent to a specified pager, with the phone number of the server, an

ID number, or other numerical information.

No shutdown Default action for all indications. Select this option if you do not want to shut
down or reset the server when an event occurs.

Shutdown the OS Select this option if you want to shut down the OS gracefully (controlled,
closing files and applications).

On NetWare, the server is returned to DOS.

On Windows NT and Windows 2000, the server is set to a state ready for
manual power-off or reset.

On UnixWare and Linux standard shutdown is completed and system prompts
for reboot or power off.

Shutdown the OS and Select this option if you want to shutdown the OS gracefully and turn off the
power off system power.
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Action

Description

Shutdown the OS and
hardware reset

Select this option if you want to shutdown the OS gracefully and reset the
server via hardware.

Immediate power off

Select this option if you want to immediately power down the server. This
action is an immediate power-off without a shutdown of the OS; it might
corrupt files.

Immediate hardware reset

Select this option if you want to immediately reset the server via hardware.
This action is an immediate hard reset without a shutdown of the OS; it might
corrupt files.

Immediate NMI

Select this option if you want to cause a hardware Non-Maskable Interrupt
(NMI). If this feature is not supported on the managed server, this option is
grayed out and disabled.

Procedure:

1. Onthe PIC main window, click beside a sensor name in the navigation pane to see the list of

available sensors.

o Uk wd

Select an entry from the list.

Select the Alert Actions tab.

Select the threshold type or state change condition.

Change the event actions associated with the selected threshold type or state change condition.
Click <Apply> to save your changes.
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Configuring Third-Party Event Actions

On the Alert Actions tab page, you can select actions that will take place when athird-party
component exceeds a threshold or changes state.

Y ou can configure event actions for the following third-party components:

e Adaptec SCSI
e LSl (Symbios) SCSI
e Intel LAN Adapter

To configure event actions for third-party indications:

1. Onthe PIC main window, click beside the third-party component name in the navigation pane.

2. Updatethe Alert Actionstab. Change the event actions associated with a threshold type or
state change condition.

3. Click <Apply> to save your changes.
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The following table provides event information for third-party component instrumentation

supported by PIC.

Version 2.4

Instrument (Notes)

Choices

Adaptec SCSI*

Storage Device Events Group:
Storage device state information
Storage device recovered error - Bad block repaired
Storage device member marked down
Storage Controller Events Group:
Storage Controller state information
Storage Controller SMART event
Storage Controller status unacceptable
Volume Set Events Group:

Volume set state information

Volume set recovered error

Volume set Array status — offline
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Configurable Third-Party Events (continued)

Version 2.4

Instrument (Notes)

Choices

Adaptec SCSI* (cont.)

Spare Events Group:
ARO spare not functional
Enclosure Events Group:
Enclosure state information

LSI (Symbios) SCSI*

Storage Devices Events Group

Device Error (not responding)

Device Warning (predicted failure(S.M.A.R.T.))
Storage Controller Events Group

Controller Error (not responding)

Mass Storage Association Events:

New Storage controller detected

New device detected

Existing controller changed

Existing device changed

Intel LAN Adapter

Indication Control Group:
Total transmit errors threshold
Total receive errors threshold
Total host errors threshold
Total wire errors threshold

* Event actions do not distinguish between instances of the same group. This means that event actions are configured
for a “class” of objects (i.e., host adapter) and not on individual instances of the group (i.e., host adapter 1, host

adapter 2).
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Switching Views Between the Primary (Managing)
Server and an ICMB Device

To view adifferent server (ICMB device) in the navigation pane of the PIC main window, do the
following steps:

1. OnthePIC Main Menu Bar, click the ICMB->View Managed Server(s) menu selection.

2. Alistof ICMB devicesisdisplayed. Select an entry from thelist to view.

3. Click <OK>.

Thetree in the navigation pane is replaced with information about the new device. At any time
you can change views to another ICMB device by repeating the steps above.

To return your view to the primary server in the navigation pane of the PIC main window, click the
ICMB->View Managing Server menu selection on the PIC Main Menu Bar.
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Configuring ICMB on the Primary (Managing) Server

To configure ICMB on the primary (managing) server, do the following steps:

1. OnthePIC Main Menu Bar, click the ICMB->View Managing Server menu selection to switch
to the primary server if you are viewing an ICMB device.

2. Inthe PIC navigation pane, click beside the ICMB component name in the navigation pane.

3. Update the ICMB tab page.

4. Click <Apply> for any changes made to the ICMB configuration.

Configuring the Watchdog Timer Value

Each motherboard supported by PIC has a watchdog timer implemented in the hardware; the timer
isdisabled by default. When enabled, the timer continually decrements to test the response of the
server operating system. Under normal operating conditions, the PIC server instrumentation
software periodically resets the time to prevent it from reaching a value of zero. If the OS hangs,
the timer will count down to zero.

If the timer reaches a value of zero, indicating an OS hang, the watchdog timer will reset the
system. The default timer value is two minutes with minimum and maximum allowabl e settings of
two to sixty minutes.
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To configure the watchdog timer value, do the following steps:
1. OnthePIC Main Menu Bar, click the Configure->Watchdog Timer Value menu selection.

2. Update the timer value.
3. Click <OK>.

ECC Memory

PIC reports memory status information, both memory arrays and memory devices, for systems that
support ECC memory. The ECC memory subsystems can detect and report both single-bit errors

(SBE) and multiple-bit errors (MBE).

Depending on the managed server hardware, memory devices are either SIMMs or DIMMSs.
Memory device references use the appropriate device name in the PIC Console software.

Single-Bit Error Handling

If a SBE occurs, the system generates an SM1 that allows the BIOS to log information about the
error in the System Event Log (SEL). Thisinformation identifies the exact SIMM or DIMM in
which the error occurred. Because this condition is recoverable, BIOS returns the system to

normal operation after logging the error.
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Thiserror isindicated in the health branch of the PIC Console software as a noncritical condition,
the requested event actions are carried out, and a noncritical error count isincremented on the
Sensor Settings tab page of the software.

Also, the following actions occur in the PIC Console software:

e TheDeviceError Typeis set to SBE on the Sensor Information tab page for the Memory
Device

e ThelLast Error Update valueis set to “During PIC Runtime,” indicating the update occurred
while the system was operational.

The BIOS stops logging noncritical SBEs when the SBE error count reaches nine. This prevents
the errors from filling the SEL. Upon system reboot, the OS uses the SEL records, along with the
results from its own memory test, to map out bad memory by reducing the usable size of a memory
bank to avoid using the bad memory element(s). This elimination of hard errorsis a precaution
that prevents SBEs from becoming MBES after the system has booted, and also to prevent SBES
from being detected and logged each time the failed location(s) are accessed. Upon reboot, the
SBE error count is set to zero in the SEL.
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Multiple-Bit Error Handling

If an MBE occurs, the system generates an SM1 that allows the BIOS to log information about the
error in the SEL, identifying the memory bank in which the error occurred. However, on some
systems, it is not possible to determine the exact SIMM/DIMM that caused an MBE.

Because an MBE is acritical condition, upon logging the error the BIOS generates an NMI that
halts the system. Upon rebooting the server, this error isindicated as a critical condition on the
Memory Array and Memory Device in the health branch of the PIC Console software. The
requested event actions are carried out, and the critical error count is incremented on the Sensor
Settings tab page of the software.

Also, the following actions occur in the PIC Console software:

e TheDeviceError Typeis set to MBE on the Sensor Information tab page for the Memory
Device.

e ThelLast Error Update value is set to Previous Boot, indicating the last update occurred
during the last system boot.
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Memory Tables

Version 2.4

The following tables compare the steps taken with Single-bit and Multi-bit errors and provide the
type of memory information available from the PIC Console software.

SBE and MBE Comparison

Memory Error Handling

SBE

MBE

Generate SMI

Yes

Yes

Log information includes

Exact SIMM or DIMM

Memory bank only

Action after SEL logging

Continue operation

Stop the system

Indicated by PIC screen changes

Immediately

After the system reboots

Bad memory is mapped out at next reboot

Yes

Yes (immediately after the failure)
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Information available on the Sensor Information tab page of the PIC Console software:

Memory Array Dialog

Item Description

Maximum Memory Capacity The maximum memory capacity in bytes on this system

No. of Memory Device Sockets The number of memory device (SIMM/DIMM) slots or sockets
available in this memory array

No. of Memory Device Sockets Used The number of slots or sockets populated by the memory

devices in this memory array

Memory Error Correction The hardware error correction or detection method supported
by this memory array

Memory Array Location The physical location of the memory array, whether on the
motherboard or an add-on board
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Information on the Sensor Information tab page of the PIC Console software:

Memory Device Information

Item Description

Size Size of the memory device in bytes.

Memory Type Type of memory used in the memory device.

Device Locator A string identifying the socket location or board position of the memory device.
Example: “SIMM 3” or “IC12.”

Device Error Type Most recent type of error that occurred on the memory device.

Last Error Update System state during the last error update.

Total Width Total width of the memory device (SIMM/DIMM including check bits), in bits.

Data Width Data width of the memory device in bits.

Type Detail More information about the memory device type.

Error Count Summary of the error status for the memory device. This read-only attribute
contains a count of all SBEs on the memory device.
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Local Response Agent (LRA) Paging

Platform Instrumentation Control lets you configure the paging features available with Baseboard
Management Controllers (BMC) and Platform Instrumentation (Pl). Actual paging activities are
performed by the BMC. If the server hardware does not support LRA, the Paging Configuration
menu itemis grayed out.

Initiating a Page

To specify that a page be sent in response to an alert, check the “Send a Page” box in the Alert
Actions dialog for the event.

Paging Configuration

Select Configure->Paging Configuration from the main menu in PIC. This configuration is global
to the server and not sensor-specific—the same page will be sent in response to all events that
have “ Send a Page” specified.

77




Intel Platform Instrumentation Control Version 2.4

Paging Configuration
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The Paging Configuration screen lets you configure the following information :

Global Paging Enabled : This checkbox specifies whether the paging feature is globally enabled
or disabled. If disabled, enabling paging action in the Alert Actions dialog has no effect.

Default Pager #: Thisisthe number paged when a paging action istriggered. If it is blank, no
paging occurs.

The Test Page button calls this number.

Additional Pager #1 and #2 : These are additional stored pager numbers. They are not called
when a paging event occurs or the Test Page button is pressed.

To page one of these numbers, you must copy it to the Default Pager # field, then initiate a paging
action or press the Test Page button.

Repeat Paging : The Repeat Paging feature pages the administrator multiple timesin acritical
situation. You may configure both the Repeat Paging Count and the Repeat Paging Interval. The
Repeat Paging Count specifies how many times the pager numbersin the list (one default and two
additional) should get paged. The Repeat Paging Interval specifiesthe interval in minutes between
sets of paging processes (a minimum of one and a maximum of three pages). The Repeat Paging
Count defaultsto 1. If the Repeat Paging Count is 1, the Repeat Paging Interval valueis not
needed. The maximum value of Repeat Paging Count is 3. Once you set the value of Repeat
Paging Count greater than 1, the Repeat Paging Interval field is enabled. The minimum and
default value of Repeat Paging Interval is 10 minutes. The maximum value is 60 minutes.
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Enter the full pager number the way it should be dialed, including the initial number if any needs
to be dialed to get dial tone, pause characters (‘,’), areacode, etc. For example, “9,6903115.”

Before applying the number, you may press the Test Page button to verify if it is correct.
Click the OK button to save the information and exit from the screen.

Click the Cancel button to restore the previous information and exit from the screen.
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Customizing PIC Administrator Options

The Platform Instrumentation Control console has several adjustable options. Y ou can set the PIC
console refresh rate, determining how PIC is updated with current information. Y ou can specify
whether temperatures display in Celsius or Fahrenheit, and whether you want to restore PIC
settings to the factory defaults. These settings are global and affect al open PIC sessions.

PIC installs with the following defaults:
e PIC console refresh interval: 15 seconds
e Temperature display format: Celsius
e Watchdog feature: off
e Watchdog timer: two minutes
e Sensor threshold values as defined in the SDR file

To configure the refresh interval or temperature display format:

1. Onthe PIC Main Menu Bar, click the View->Options menu selection.

2. Change the refresh interval or temperature display format on the Options dial og.
3. Click <OK>.
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[] NoTE
When configuring the console refresh interval, selecting a frequent refresh
interval impacts system performance on both the console and the managed
server because the ISC polls for the health status of each monitored sensor.
Selecting aless frequent console refresh interval provides areasonable
information update, while minimizing the overhead on system performance.
The consol e refresh interval does not impact how quickly the server system
responds to event notifications (e.g., threshold crossings) only how quickly
the ISC main screen display updates with server information. A value of 15
seconds or greater for console refresh value provides a reasonable
compromise.

To restore default PIC settings for threshold values, console refresh interval, and the watchdog
feature:

1. OnthePIC Main Menu Bar, click the Configure->Restore Factory Defaults menu selection.
2. Click <OK> on the confirmation dialog.

[1 NoTE

Event actions you have configured and the temperature display format are
not affected by the Restore Factory Default option.
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Default threshold values are stored in Sensor Data Records (SDR) in
nonvolatile storage on the motherboard. These values are determined and
configured during motherboard manufacturing and are therefore not
documented in this manual.

A CAUTIONS

Indications may be generated if the restore of the default threshold value
crosses the current sensor value. For example:

User defined threshold limit 13.5V
Current sensor value 13.0 V
Default threshold value 12.5 V

When you select the Restore Default Settings action, threshold restore may
cause athreshold crossing. In the above example, PIC would detect a
threshold crossing and generate an indication. The actions associated with
that indication would occur.

To avoid the possibility of unwanted indications when restoring defaults
settings, adjust the user-defined threshold value so the current sensor valueis
not between the user-defined threshold value and the default threshold value.
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PIC Event Messages

PIC allows you to configure event actions to be taken on the managed server when an event
occurs. These actions include audio/visual notifications, such as:

e Display an alert message
e Write amessage to the LCD
e Broadcast a message

The message text is based on the event information. This text contains the DMI MIF group and
attribute information that caused the error.

Alert Messages on the Server Console

The following table lists the alert messages that display on the server console. The general format
of these messagesis:

Event reported for <at t ri but e_name> attribute in the <gr oup_nanme> group.
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Alert Message

Description

Event reported for Upper Critical Threshold
attribute in the Temperature Sensor group.

A temperature sensor on the system reported that the
current value is above the upper critical range.

Event reported for Upper Noncritical Threshold
attribute in the Temperature Sensor group.

A temperature sensor on the system reported that the
current value is above the upper noncritical range but
below the upper critical range. This message is also
generated when the temperature returns to the
acceptable range.

Event reported for Lower Noncritical Threshold
attribute in the Temperature Sensor group.

A temperature sensor on the system reported that the
current value is below the lower noncritical range but
above the lower critical range. This message is also
generated when the temperature returns to the
acceptable range.

Event reported for Lower Critical Threshold
attribute in the Temperature Sensor group.

A temperature sensor on the system reported that the
current value is below the lower critical range.

Event reported for Upper Critical Threshold
attribute in the Voltage Sensor group.

A voltage sensor on the system reported that the
current value is above the upper critical range.

Event reported for Upper Noncritical Threshold
attribute in the Voltage Sensor group.

A voltage sensor on the system reported that the
current value is above the upper noncritical range but
below the upper critical range. This message is also
generated when the voltage returns to the acceptable
range.
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Alert Message

Description

Event reported for Lower Noncritical Threshold
attribute in the Voltage Sensor group.

A voltage sensor on the system reported that the
current value is below the lower noncritical range but
above the lower critical range. This message is also
generated when the voltage returns to the acceptable
range.

Event reported for Lower Critical Threshold
attribute in the Voltage Sensor group.

A voltage sensor on the system reported that the
current value is below the lower critical range.

Event reported for Current Status attribute in the
Security Sensor group.

System chassis front panel or side panel has been
opened (or it was open and has been closed).

Event reported for Current Status attribute in the
Cooling Fan group.

System fan has stopped (or restarted).

Event reported for Array Error Type attribute in
the Memory Array group.

A memory error has been reported on the system.

Event reported for Event Status attribute in the
Logical Unit group.

A SCSI device reported a state change.

Event reported for Event Status attribute in the
Host Adapter group.

A SCSI board reported a state change.

Event reported for Operational State attribute in
the Controller Information group.

A RAID controller reported a state change.
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Event reported for Operational State attribute in
the Physical Drive Information group.

A RAID drive reported a state change.

Event reported for Processor Status attribute in
the Processor group.

A processor sensor on the system reported a processor
error.

Event reported for Power Unit Redundancy
Status attribute in the Power Unit Global Table

group.

The power supply redundancy sensor on the system
reported a power supply redundancy state change.

Event reported for Total Transmit Errors
Threshold attribute in the Indication Control

group.

The LAN Adapter reported that the number of transmit
errors is above the threshold value.

Event reported for Total Receive Errors
Threshold attribute in the Indication Control

group.

The LAN Adapter reported that the number of receive
errors is above the threshold value.

Event reported for Total Host Errors Threshold
attribute in the Indication Control group.

The LAN Adapter reported that the number of host
errors is above the threshold value.

Event reported for Total Wire Errors Threshold
attribute in the Indication Control group.

The LAN Adapter reported that the number of wire
errors is above the threshold value.

Event “Status Changed to OK” reported in the
Voltage Probe group.

A Voltage probe changed its status to an OK state.
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Server Console Alert Messages (continued)

Event “Status Changed to Lower Critical” A Voltage probe changed its status to Lower Critical
reported in the Voltage Probe group. state.
Event “Status Changed to Upper Critical” A Voltage probe changed its status to Upper Critical
reported in the Voltage Probe group. state.
Event “Status Changed from OK to Lower A Voltage probe changed its status from normal to
Noncritical” reported in the Voltage Probe group. | Lower Noncritical state.
Event “Status Changed from OK to Upper A Voltage probe changed its status from normal to
Noncritical” reported in the Voltage Probe group. | Upper Noncritical state.
Event “Status Changed from Lower Critical to A Voltage probe changed its status from Lower Critical
Lower Noncritical” reported in the Voltage Probe | to Lower Noncritical state.
group.
Event “Status Changed from Upper Critical to A Voltage probe changed its status from Upper Critical
Upper Noncritical” reported in the Voltage Probe | to Upper Noncritical state.
group.
Event “Status Changed to OK” reported in the A Temperature probe changed its status to an OK state.
Temperature Probe group.
Event “Status Changed to Lower Critical” A Temperature probe changed its status to Lower
reported in the Temperature Probe group. Critical state.

continued
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Event “Status Changed to Upper Critical”
reported in the Temperature Probe group.

A Temperature probe changed its status to Upper
Critical state.

Event “Status Changed from OK to Lower
Noncritical” reported in the Temperature Probe

group.

A Temperature probe changed its status from normal to
Lower Noncritical state.

Event “Status Changed from OK to Upper
Noncritical” reported in the Temperature Probe

group.

A Temperature probe changed its status from normal to
Upper Noncritical state.

Event “Status Changed from Lower Critical to
Lower Noncritical” reported in the Temperature
Probe group.

A Temperature probe changed its status from Lower
Critical to Lower Noncritical state.

Event “Status Changed from Upper Critical to
Upper Noncritical” reported in the Temperature
Probe group.

A Temperature probe changed its status from Upper
Critical to Upper Noncritical state.

Event “Internal Error” reported in the Processor
group.

A system processor reported an internal error.

Event “Thermal Trip Error” reported in the
Processor group.

A system processor reported a Thermal Trip error.

Event “FRB Error” reported in the Processor
group.

A system processor reported an error during the FRB
(Fault Resilient Boot) sequence.

89

continued




Intel Platform Instrumentation Control Version 2.4

Server Console Alert Messages (continued)

Event “Redundancy Lost” reported in the Power | A power unit on the system lost the redundancy state.
Unit Global Table group.

Event “Redundancy Regained” reported in the A power unit on the system regained the redundancy
Power Unit Global Table group. state.

Event reported on the Storage Device Event A predictive failure noncritical on a SCSI device.
Type attribute in the Storage Device Events

group.

Event reported on the Storage Controller Event | A SCSI controller reported a state change.
Type attribute in the Storage Controller Events

group.

Event “Status Change to OKk” reported in the A PHP slot changed its status to OK.
System Slot group.

Event “Status Changed to Non-Critical” reported | A PHP slot changed its status to Non-Critical.
in the System Slot group.

Event “Status Changed to Critical” reported in A PHP slot changed its status to Critical.

the System Slot group.

Event “Slot Power On” reported in the System A PHP slot changed its power state from Off to On.
Slot group.

Event “Slot Power Off” reported in the System A PHP slot changed its power state from On to Off.
Slot group.
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Broadcast and LCD messages

The following table lists broadcast and L CD messages.

Broadcast messages are sent across the network to client computers. The general format of
broadcast messagesis:

Check <group_name> at server <server_name>

L CD messages are displayed on the managed server’sLCD. These are limited to 32 characters;
longer messages are truncated. The general format of LCD messagesis:

Check: <group_name>

Table 19. Broadcast and LCD Messages

Message Description

Check: Temperature Sensor. A temperature sensor reported a change in state

Check: Temperature Probe. (OK/Noncritical/Critical).

Check: Voltage Sensor. A voltage sensor reported a change in state

Check: Voltage Probe. (OK/Noncritical/Critical).

Check: Security Sensor. System chassis front panel or side panel has been opened (or
Check: Physical Container Global Table. | it was open and has been closed).

Check: Cooling Fan. System fan has stopped (or restarted).

continued
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Table 19. Broadcast and LCD Messages (continued)
Message Description
Check: Memory Array. A memory error has been reported on the system.
Check: Host Adapter. A SCSI board reported a state change.
Check: Logical Unit. A SCSI device reported a state change.
Check: Controller Information. A RAID controller reported a state change.

Check: Physical Drive Information. A RAID drive reported a state change.
Check: Processor. A processor error has been reported on the system.
Check: Power Unit Global Table. A power unit redundancy state change has been reported on

the system.

Check:

Power Supply.

A power supply failed on the system.

Check:

Indication Control Group.

The LAN Adapter reported a threshold crossing.

Check:

Storage Device Events.

A SCSI device reported a state change.

Check:

Storage Controller Events.

A SCSiI controller reported a state change.

Check

: System Slot.

A PHP slot reported a state change.
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Appendix A DMI to SNMP Translator

Y ou can use the DMI-SNMP Translator to integrate DMI management with SNMP. The translator
attaches directly to the Network OS' s SNMP agent and to the DMI Service Layer by registering as
amanagement application. The trandator translates management requests from SNMP to DMI

and responses from DMI to SNMP. DMI events (indications generated by the component
instrumentation when athreshold is crossed or a sensor changes state) are translated into
enterprise-specific SNMP traps.

The trandlator translates these MIFs:

» Baseboard

« ICMB

e Loca Response Agent
e Adaptec SCSI

e LSl (Symbios) SCSI
e Intel LAN Adapter

The translator raises atrap when aDMI indication isreceived. The DMI-SNMP Translator does
not support configured actions. This alerting mechanism works independently of the Local
Response Agent.
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For the DMI-SNMP Tranglator to work correctly, the SNMP Agent on the managed server OS
must be configured correctly. For example, the Windows NT, Windows 2000, NetWare, Linux, or
UnixWare SNMP Agents need some configuration to enable the server to send SNMP traps to
specific SNMP management consoles. To configure the SNMP Agent on the server, seethe
documentation supplied by the OS vendor.

To manage the DMI information on Windows NT, Windows 2000, Netware, and UnixWare
servers supplied by PIC software through the SNM P management workstation, the following MIBs
must be compiled on the SNMP console;

« ADAPTECMIB

+ BASEBRD.MIB

+ BASEBRD2.MIBa

+ BASEBRD3.MIB

« CIO.MIB

+ [EI00B.MIB

 ICMBFEAT.MIB

* INTELNIC.MIB

* LRA.MIB
* RMTCHASMIB
« SHA.MIB

« SYMBIOS2.MIB
» SYMSDMS2.MIB
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To manage the DMI information on Linux servers supplied by PIC software through the SNMP
management workstation, the following MIBs must be compiled on the SNMP console:

+ MAPBASE2.MIB

+ MAPLRA.MIB

+ MAPSHA.MIB

These MIB files are installed during the PIC Console and PIC Server installation. Thefilesare
copied to the %PIC_PATH%\SNMPMIBS directory during installation. PIC_PATH isthe
installation directory chosen during install.

The procedures for compiling these M1Bs depend on the SNMP console being used. For more
information, see the documentation supplied with your SNMP console software.
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